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1.   Introduction and login 
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1.1.   Introduction 

  
Aplusix 3 is an application designed to help 11-17 years old students learn algebra. The main goal of Aplusix 
is to help students improve their problem solving skills. Students perform their own calculations by typing 
in expressions and proceeding step by step, as on paper. Aplusix can tell whether the calculations are 
correct and when the problem is solved. Aplusix also provides a solution for each question and can score 
students' solutions. 

  

In version 3, three companions have been added to Aplusix.  They can provide students with hints and 
show them the next steps in their calculations. Chloe is 12, Julien is 14 and Olivia is 16 (approximate ages). 
As the knowledge a student has acquired at a given age depends on many factors, it is incumbent on the 
student or his/her teacher or tutor to select the most appropriate companion (a different companion could 
be used when practising different skills). 

  

When the exercise question is of one of the types Calculate (for numerical calculations), Expand and 
simplify, Simplify, Factorise or Solve (equations, inequalities or simultaneous equations), Aplusix can tell the 
student when the question is solved. Exercise questions without type can also be solved but Aplusix cannot 
tell when the question is solved. 

  

Problems are divided into sections composed of information and questions. Answers are expressions that 
are compared with the model answer provided by the problem designer. A problem section can be an 
exercise question requiring working out. For example, the terms of a problem could first require the 
student to write an equation and then to solve this equation. 

  

Aplusix   is a Windows application. In schools, it can be installed on a server and accessed via the school 
network. It can also be installed on standalone computers either in schools or at home. 

  

Aplusix 3 is made of three modules: 

-   The student environment, Aplusix.exe, can also be used by teachers to monitor students’ activities and 
adapt its settings to the needs of a particular group. 

-   The exercise editor, AplusixEditor.exe, allows teachers to create exercise and problem files. It has its own 
user manual. 

-   The administration application, AplusixAdmin.exe, allows teachers to manage their classes on the server. 
It has its own user manual. 
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1.2.   Login 

  

In the School version, Aplusix 3 uses logins and passwords. There are two types of users: students and 
teachers. 

  

The administration application allows teachers to create classes, teacher accounts and student accounts. 
Students can also create their own accounts from the start window. 
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When teachers log into Aplusix, they may opt to use it in the context of one of their classes. This allows 
them to experience the same environment as their students, but also to change the settings for this 
particular class (using the "Settings" menu). 

  

All users can change their password with the "File" menu. 

  

In the Home and single-user versions, Aplusix 3 uses “usernames” for students. There is a maximum of   
students for the Home version. 
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2.   Starting with Aplusix 
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2.1.  First use 

  

Start Aplusix. A window opens with an empty question in “Practice” mode. 

  

Type in a question to be solved: using either the computer keyboard or the virtual keyboard, enter the 
equation            . 

Then choose the “question type” that indicates what must be done with this expression. To do this, click on 
the dotted rectangle above the equation or select “Specify the question type” in the “Step” menu. Select 
“Solve” from the drop-down list and close the small window so that you should see the following: 

  

Now, you can start solving the equation. Select “New step” in the “Step” menu. You get: 

  

Type in your equation for the second step (steps are represented as boxes around expressions). Type 
           (yes, it is incorrect!) in the box. You should see: 

  

The crossed double red line between the steps means that the calculation is incorrect. Right click and select 
“Score” in the contextual menu to check your score. You get 0/20 which is not unexpected as your 
calculation is incorrect. To correct the calculation, insert a minus sign before 2. You should see: 
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The double line is now black and not crossed which means that the calculation is correct. If you check your 
score again, you should see that it has increased. 

  

Now create a “New step” and write     .  Then check your score. You get 19/20. This is not the maximum 
score because you have not yet indicated that the equation is solved. Click on the “Done” button and select 
“Solved”. Aplusix replies “Well done, the question is completed” and the question background becomes 
grey to indicate that it has been completed. Then check your score. You get 20/20. 

  

In the same manner, you can solve other questions from books or from worksheets provided by your 
teacher. 

  

In the example above, you worked in the mode “Check calculations permanently”. This mode can be 
selected from the “Settings” menu. You can work in a different mode called “Check calculations on 
request”, also in the “Settings” menu. In this mode, Aplusix does not tell you whether your working out is 
correct. It simply draws a single line between two steps to indicate that one step follows the other. 

You have to decide when to check if your calculations are correct. Do this by clicking on the “Check 
equivalence” button on the toolbar. 

  

It is also possible to limit the number of available checks for each question to   or   by selecting the 
appropriate options in the "Settings" menu. 
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2.2.  Second use 

  
Now you are going to solve exercise questions from “The Map” of Aplusix. 

  

First, start Aplusix. You are now in “Practice” mode. Click on “The Map” button and choose one of the two 
maps (numerical or algebraic). A new window appears with dots of various colours. Each dot corresponds 
to a question family.  To assist with your choice, you can select a level using the “Level” menu where can 
choose a country and a school level (grade) in the country. When you select a dot by clicking on it, the dot 
is outlined in black and the question family it relates to is described at the bottom of the window. Choose a 
question type that you are comfortable with. Next, select “Practice” in the menu. Aplusix puts you in 
“Practice” mode with a list of questions to be solved. You can see the number of questions in the toolbar. 

  

You can move from one question to another with the two navigation arrows. Questions can be attempted 
in any order. Once you start working on a question, the navigation arrows are disabled. To move on to 
another question, you must first quit the current question by clicking the “Done” button. 

  

Aplusix randomly generates new questions in The Map every time you request an exercise from a particular 
family so that if you try the same question family several times, you will get different questions every time. 
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2.3.  Third use 

  

  

While in “Practice” mode, solve a few questions from the family that you chose previously. Then you will 
take your first test. Go to The Map, click on the appropriate dot for the same family and select “Test” in the 
menu. Aplusix puts you in “Test” mode. This is indicated on the left end of the toolbar together with the 
time you have remaining to complete the test. 

  

Solve two or three test questions then click on the button “Quit test” and confirm in the dialog box. Aplusix 
displays your score. If you have solved only two or three questions, this score will be low because you must 
solve all the questions correctly to achieve the maximum score. This does not matter now since the 
purpose of doing this test was just to learn how Aplusix works. In the same dialog box, Aplusix asks you if 
you would like to enter “Self-correction” mode. Answer “yes”. As displayed on the left of the toolbar, you 
are now in “Self-correction” mode. You can see the first question as you solved it. 

  

Incorrect calculations are marked in red. If there are incorrect calculations, the word “Solved” is crossed 
out. This will also happen if the final answer is not given in the required form. The question number, along 
with your score, is displayed in the toolbar. 

  

If your question is not correctly solved, click on the “Edit the question” button. You can now alter you 
solution to solve the question correctly with the help of the calculation checker. 
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3.   Modes 
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3.1.   "Practice" mode 

  

In “Practice” mode, students can perform the following actions. 

  

Enter a question taken from a textbook or worksheet, as explained in the section “First use”. To generate a 
fresh calculation sheet, choose “New sheet” in the “File” menu or click on the “New sheet” button. 

  

Attempt questions from The Map, as indicated in the section “Second use”. 

  

Attempt questions from a file. Select “Open” in the “File” menu or click on the “open” button then choose 
a file ending in “.exo”. These files contain questions or problems. When a file does not have an execution 
mode, Aplusix asks the student whether to use “Practice” or “Test” mode. 

  

Save the current calculation sheet in a file. Select “Save as” in the “File” menu and enter the file name. A 
calculation sheet is the work currently displayed on the computer screen. Calculation sheet files end in 
“.alg”. 

  

Open a file containing a calculation sheet. Select “Open” in the “File” menu or click on the “open” button 
then choose a file ending in “.alg”. The file may have been previously saved or may be provided by other 
people. When it is opened, students can edit the calculation sheet by clicking on the “Edit question” button. 

  

Print the current calculation sheet. Select “Print” in the “File” menu. 
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While solving a question, students can check their score at any time by right-clicking. A right click also 
allows them to request the solution. 

  

The “Quit exercise” button allows students to cancel the exercise and obtain a fresh calculation sheet. 
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3.2.   "Test" mode 

  

The Test activity provides a 30-minute test on an exercise chosen from The Map or from a file. The duration 
of a test can be different when the exercise comes from a file. A test is generated from The Map by clicking 
on a dot (representing a question family) and choosing “Test” in the “Launch” menu or by opening an 
exercise file and choosing the ‘Test’ mode. 

  

The remaining time is indicated on the left hand side of the toolbar. After completing a question, students 
can edit their solutions by clicking on the “Edit question” button. 

  

A test is finished when any one of the following happens: 

-   All questions have been completed by the student or abandoned. 

-   The time is over. 

-   The student clicks on the « Quit test » button. 

-   The student quits Aplusix. 

  

In the three first cases, Aplusix gives a score and provides students with an opportunity to correct their 
solution using a “Self-correction” activity. 
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3.3.   Past Activities 

  

The “Past activities” menu contains a “Review/correction” item that opens a window allowing students to 
review their previous work. A past activity can be selected in this window by selecting an item in each 
column. 

  

Students access previous activities by date (first column) then by time and activity mode (second column). 
A description of the selected activity is provided at the bottom of the window. Teachers have two 
additional columns (on the left) allowing them to select classes and students. 

  

The user (teacher or student) can review the selected activity (see section “Review mode”). A student can 
perform a Self-correction of “Practice” or “Test” activities. 
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3.4.   Self-correction mode 

  

In Self-correction mode, students may review the calculations they have made in a “Test” or “Practice” 
activity. Students can edit the questions they have solved incorrectly by clicking on the “Edit question” 
button. Students should benefit from the immediate feedback on their work. 

  

Students can self-correct at the end of a test by answering “yes” when Aplusix suggests to do so. They can 
also self-correct later via the “Past activities” menu. 

  

In self-correction mode, students’ previous calculations are displayed exactly as they were when the 
students quit the exercise. Incorrect calculations are marked in red. The word “Solved” is crossed out 
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because there are incorrect calculations. It will also be crossed out if the answer is not given in the correct 
form. The score is displayed in the toolbar. 
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3.5.   Review mode 

  

In Review mode, students can view the questions they have attempted and use the replay system to see 
the details of their actions. Teachers can activate this facility for their students. 
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4.   The Exercise Maps 

  

Aplusix contains two exercise maps: one for numerical calculations, the other for algebraic calculations. 
Each map presents question families as dots organised in a plane. Each horizontal line corresponds to a 
question type; each column corresponds to a degree of difficulty. See the “Domain” section for more 
details on question types. 

  

When a dot is clicked, it is outlined in black and a description of the question family is displayed in the 
bottom panel. 

  

Using the “Level” menu one can view question families corresponding to a specific level in a particular 
country. 
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5. Editing 
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5.1.   The virtual keyboard, the toolbar and the state bar 

  

The virtual keyboard can be brought up on the computer screen by selecting “Virtual keyboard” in the 
“Edit” menu or by clicking on the “Virtual keyboard” button on the toolbar. Operators that can be applied 
to the current expression are outlined with a blue box. 

  

By default, the toolbar (which is below the menu bar) displays from left to right: 

- the current mode on a coloured background; 

- a small blank box to delete the content of the current step (this is the currently edited step or the step 
containing the current selection), 

- a small crossed-out blue box to delete the current step and all its children; 

- an equivalence symbol with a question mark to check whether all steps are correct (when checking is 
done on demand); 

- a virtual keyboard icon to display the virtual keyboard; 

- a button to specify when the question has been completed (or that the student wants to leave it as it is), 
or to edit a previously attempted question; 

- the question number of the current question in the exercise, surrounded by navigation arrows (when the 
arrows are deactivated, it means that navigation is disabled while the question is being attempted); 

- a button to  discard the current sheet and start a new blank sheet; 

- a button to open a file; 

- a button to abort the current exercise; 

- the "The Map" button to access many built-in exercises. 
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The state of the expression in the current step is displayed in the status bar at the bottom of the window. 

  

The "zoom" menu of the virtual keyboard allows to increase and to decrease the size of the characters of 
the virtual keyboard. 
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5.2. Input 

  

It is possible to type in mathematical symbols with the computer keyboard and with the virtual keyboard. 

  

Buttons with icons representing their function make the virtual keyboard very intuitive. There are buttons 
for the four arithmetical operations (addition, subtraction, multiplication, division) and for functions 
(square root, power). There are also buttons for logical operators like “or” or relations like “=”, “<”. 

  

Missing arguments 

Missing arguments for operators appear as by blue question marks. 

  

Brackets 

A pair of brackets can be inserted with the “Brackets” button of the virtual keyboard. However, when an 
opening or closing bracket is inserted using the computer keyboard or the virtual keyboard it is unmatched. 
Unmatched brackets are displayed in blue. 

  

Decimals 

Decimals can be written using the computer keyboard or the virtual keyboard. 

  

Fractions 

There are several ways to write fractions using the virtual keyboard: 

-   click on one of the “fraction” buttons then fill in the numerator and the denominator; 

-   select an expression and click on one of the fraction buttons then fill in the missing part; 

-   first write an expression then click on the “/” button or press the “/” key, then fill in the denominator; 

Divisions can also be written with the “:” operator sign. Note that this sign is not accepted in answers (e.g. 
“5:3” is not accepted as an answer and has to be replaced with “5/3”). 

  

Square roots 

The square root of a number can be obtained by first writing the number, selecting it, and clicking on the 
“square root” button. Alternatively, it can be obtained by first clicking on the “square root” button then 
filling in the box under the square root sign. 

  

Powers 

Powers can be entered with the “power” button on the virtual keyboard or by pressing the “^” key. An 
expression may be squared using these methods or, alternatively, using the “square” button. 

  

Simultaneous equations 

The button with the large curly brace provides for simultaneous equations. The large curly brace is 
equivalent to the logical “and” operator and can also be obtained by typing “and” on the keyboard. 

  

Unions of values and intervals 

The “or” operator can be input by typing “or” on the keyboard or clicking on the “or” button on the virtual 
keyboard. It allows multiple solutions of equations such as               and inequalities such as 
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Conditions 

Polynomial and rational expressions of one variable can have a condition. In this situation, the “with” 
operator must be used. This is required, for example, when a simplification which modifies the definition 

set is performed.  For example, when one simplifies  
     

(    )(    )
, one must provide: 

 

     
         to get 

an equivalent expression. 

  

Conditions are linear inequation/inequalities in one variable or combinations with “and”, “or”, “not” of 
such relations. A condition must determine an infinite set of real numbers. When there is a condition in an 
answer, it must be simplified to be accepted by Aplusix as a correct answer. 

  

Comments 

For each step of the solution, it is possible to write comments in the dotted boxes provided. To write a 
comment, click on these dotted rectangles. To edit a comment, simply click on it. 

  

Fonts 

The “Settings” menu allows different fonts and sizes to be used. 
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5.3.   Insertion point, deletion 

  

The insertion point is displayed either as a small vertical bar or as a question mark in a grey box. It shows 
where the next input character will be placed. 

  

Steps are boxes in which expressions are written. The current step is the one that contains the insertion 
point. Its frame is drawn with a thicker line and an additional green line. 

  

The insertion point can be moved to a specific position with a mouse click. It can be moved with the Right, 
Left, Up and Down keys on the computer keyboard, or with virtual keyboard buttons. 

  

There are two ways to delete using the computer keyboard: to the left (Backspace) and to the right (Del). 
The corresponding “delete” buttons on the virtual keyboard (represented as small erasers) also allow 
deletion to the left and right of the insertion point. 

  

When one bracket is deleted, the other matching bracket is also removed. A fraction is deleted in one step. 

  

When the insertion point is a question mark, the deletion keys remove the operator having the question 
mark as an argument. For example, if the question mark is the denominator of a fraction, the fraction sign 
is deleted but the numerator remains. 

  

When a deletion does not produce the expected outcome, the user can cancel it using the “Undo” button 
which means “Cancel the previous action”. 
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5.4.   Selection 

  

Aplusix only allows selections that respect algebraic structure. This means that only algebraic sub-
expressions can be selected. For example,     and    cannot be selected in        
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When part of an expression is already selected, a ctrl-click on a non-selected part adds to the selection and 
conversely, a ctrl-click on a selected part deselects this part. In this manner it is possible to select   and   in 
      also   and   in     . 

  

When a sub-expression is selected: 

-   typing a digit or a letter replaces the selection; 

-   entering an operator with one variable, such as the square root or a minus sign, applies this operator to 
the selection; 

-   pressing a deletion key deletes the selection; 

-   A click on a button of the virtual keyboard with a blue part (representing a selection) applies the operator 
to the selection. For example, one can select a sub-expression and make it the numerator of a fraction by 
clicking on the appropriate “fraction” button. 

  
Sommaire 

5.5.   Cut, copy, paste, drag&drop 

  

When a sub-expression is selected: 

-  selecting “Cut” in the “Edit” menu deletes the expression and puts on the clipboard for later pasting; 

-  selection “Copy” in the “Edit” menu retains the expression and put it on the clipboard for later pasting. 

  

The “Paste” operation of the “Edit” menu can be used when: 

-      An expression is selected or the insertion point is a question mark. In this case, the selected expression 
is replaced with the algebraic expression on the clipboard. This may introduce brackets. For example, when 
the clipboard contains     and it is pasted into       with   selected, the result is  (     )    . 

-      The insertion point is a vertical bar. In this case, the expression on the clipboard is inserted at this 
place. It is linked with the adjacent expression with an operator which is usually + or   . When this operator 
is not the one expected, it is necessary to replace it manually with the correct one. 

  

The “Cut”, ”Copy” and “Paste” commands can also be found in the contextual menu that appears when 
right-clicking, and on the virtual keyboard. 

  

The “Drag&drop” operation involves selecting a sub-expression, left clicking on the selection then moving it 
without releasing the mouse button. When the cursor is at the correct insertion point, releasing the mouse 
button moves the sub-expression. As in the pasting operation, Aplusix inserts a connecting operator that 
may have to be changed manually. “Drag&drop” produces the same result as “Cut” and “Paste” when it 
happens within the same step. When the “Drop” is in another step or when the “Drop” is performed while 
the “Ctrl” key is down, “Drag&drop” produces the same result as “Copy” and “Paste”. 

  

Examples of the using “Drag&drop”. 

-   To change         –   into      –  –   “Drag&drop”   to the right of 3, then select   and type a 
minus sign. 

-   To change          into   
     

 
 , select     then click on the “fraction” button. Finally 

“Drag&drop”    into the denominator of the fraction. 

  

Example of “Copy” and “Paste”. 

-      In the simultaneous equations  {
        

           
to substitute        into the second equation, 

select and copy     then select   in              and perform a paste. Aplusix adds brackets 

automatically, ending in: {
       

      (     )    
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5.6.   Building calculations 

  

Students display their calculations in successive steps using a sequence of boxes. 

  

The “Step” menu provides commands for creating, deleting the content of and removing steps. The 
commands “New step” and “Duplicate” allow the current calculation to be continued. The “New step” 
command creates a blank box to be filled in while the “Duplicate” command replicates the previous 
expression. 

  

The small arrow at the bottom right of the current step allows “New step” or “Duplicate” to be executed 
depending of the value of a setting that can be changed in the “Settings” menu. 

  

“Delete” empties the current step. There is a “Delete” button on the toolbar. 

  

“Suppress” quits the current step and all its children. There is a “Suppress” button on the toolbar. 

  

“New detached step” allows creating a step independent of the other calculations, in order to perform an 
independent calculation in a draft area. 
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6.   Calculation Commands 

  

The “Calculations” menu and the contextual menu (right button of the mouse) contain commands that 
allow calculations to be performed by the computer. These commands can be tuned or disabled via the 
"Settings" menu.  They apply to a selected sub-expression and replace the sub-expression with the result of 
the calculation. Currently there are six commands. 

  

Calculate indicates that a numerical calculation will be performed by Aplusix. Calculate replaces a 
numerical expression, like       by its value    . It can be disabled or limited to integers, decimal 
numbers or fractions. 

  

Expand and simplify indicates that the expression will be expanded and simplified. A polynomial expression 

such as  (       )is replaced with          , its expanded and simplified form. It can be disabled. 

  

Factorise replaces a polynomial expression such as            with  (       ), its factorised form. It can 
be disabled or limited to linear or quadratic expressions in   or   variables. 

  

Solve replaces a polynomial equation of one unknown such as          with its solutions            

 
 

 
 . It can be disabled or limited to linear or quadratic equations. 

  

To decimal replaces fractions with their decimal equivalent when they exist. For example, the decimal 

equivalent of   
 

 
  

 

 
  is              . It is enabled when the Calculate command is enabled for 

fractions. 

  

To fraction replaces the decimal numbers by their fraction equivalent. For example, the fraction equivalent 

of              is 
 

 
  

 

 
  . It is enabled when the calculate command is enabled for fractions. 

  
Sommaire 
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7. Feedback 
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7.1.   Equivalence checks 

  

Aplusix can check that two connected steps contain equal numerical expressions, equal algebraic 
expressions, equivalent equations, equivalent inequalities, or equivalent simultaneous equations. The 
“Settings” menu enables users to choose between constant checks and checks on request,  possibly with a 
maximum of   or   checks per question. In the latter case, the “Check equivalence” button must be pressed 
to perform a check. When the number of checks is limited, each check decreases then number of remaining 
checks. When the number of checks is 0, equivalence cannot be checked. The number of checks is 
displayed on the Status bar. 

  

The result of an equivalence check is shown on the links between steps. These links are: 

-   A single black line means “No check was performed”. 

-   A double black line means “The expressions are equal” or “The equations, inequalities, simultaneous 
equations are equivalent” 

-   A crossed double blue line means “One expression is incomplete or undefined”. 

-   A crossed red double line or arrow means “The expressions are not equal” or “The equations, 
inequalities, simultaneous equations are not equivalent”. 

Remark: two equations are equivalent if and only if they have the same set of solutions. 

  

All algebraic expressions in Aplusix are considered to be over the set of real numbers. 

  

Aplusix checks calculations in the following manners: 

  

-   For the Calculate, Expand and simplify and Factorise question types, the domains of the expressions  (i.e., 
sets of values for which the expressions are defined) and their canonical forms are calculated. There is 
equivalence when the two domains and the two canonical forms are identical. When an expression 
contains a “with” operator, the domain is the intersection of the domain of the expression to the left of 
“with” and the set determined by the condition to the right of “with”. 

  

-      For the Solve question type, canonical forms of the solution sets of the equations, inequalities, 
combinations of relations, simultaneous equations are calculated. There is equivalence when the two 
canonical forms are identical. 

  

Canonical forms calculated to a finite degree of accuracy. Equality of numbers is judged to    significant 
figures. 

  
Sommaire 

7.2.   Solutions and checking students' work 

  

In “Practice” and “Self-correction” modes, Aplusix provides the solution on request (right-click). 

  

In “Practice” and “Self-correction” modes, Aplusix checks that the question is solved when the student says 
“Solved”. Whether or not a question has been correctly solved is determined by the last step (or the last 
steps when several branches have been developed) of the question. Firstly, the path from the initial 
expression to the last step must contain only well-formed expressions and correct calculations. Secondly, 
the expression in the last step must be in solved form. Note: It is possible to quit a question without solving 
it by clicking on “Done” button and selecting “I leave the question as it is”. 
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When equivalence checking is limited to   or   checks, the same limit applies to feedback on the answer 
and no information is given about the correctness of the calculations leading to the last step. 

  

A “Calculate” type question is solved when the expression is a number written in a canonical form (integer, 
decimal, rational or irrational). 

  

A question of type “Write as a fraction” is solved when the expression is a number written in integral or 
rational canonical form. 

  

A question of type “Write as a decimal” is solved when the expression is a number written in decimal 
canonical form. 

  

A question of type “Expand and simplify”, with an expression that does not contain square roots, is solved 
when the expression has no brackets (neither explicit nor implicit, such as a sum in the numerator of a 
fraction) and is simplified. 

  

A question of type “Expand and simplify” with an expression that contains square roots is solved in two 
situations: 

-   When the expression is in canonical polynomial form. 

-   When the expression has no brackets (neither explicit nor implicit, such as a sum in the numerator of a 
fraction) and is simplified. 

  

A question of type “Factorise”, with a linear expression, is solved if all constant common factors have been 
factorised. 

  

A question of type “Factorise”, with a polynomial expression of degree greater than 1, is solved if the 
expression is a product of simplified prime polynomials (prime polynomials are first-degree polynomials 
and second degree polynomials without real roots). Note that Aplusix does not require constants to be 
factorised in an expression representing a polynomial of degree greater than 1. 

  

A question of type “Solve”, except in the special cases described below, is solved: 

-   For an equation, when the expression is     , where   is a numerical expression in its simplest form, or 

where                   ,           are numerical expression in their simplest forms. 

-   For an inequality, when the expression is       or     or     or     where   numerical 
expression in its simplest form. 

-   For simultaneous equations, when the expression is   {
     

     

  
where             are numerical 

expressions in their simplest forms. 

  

The special cases for “Solve” are: 

-   When there is no solution. In this case, no particular answer is expected; the student should click on the 
“Done” button and select “No solution”. 

-   When any number, for each variable, is a solution. In this case, no particular answer is expected; the 
student should click on the “Done” button and select “Any number is a solution”; 

-   When a simultaneous equations with N unknowns lead to more than zero but less than N equations, it 
must have an answer in which some variables are expressed in terms of others; for example, for the 

equations  {
        

           
a correct answer would be        . 
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Remember that all mathematical objects and concepts in Aplusix are considered to be over the set of real 
numbers. This has a bearing what is considered to be a factor of a polynomial expression and a solution of a 
non linear equation. 
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7.3.   Companions 

  

Aplusix companions are virtual characters who can make suggestions and perform calculation steps on 
request.  There are three companions.  The "Companion" menu allows the user to select the active 
companion.  It also allows to get assistance from the active companion: 

  "Suggest an expression here" lets the companion highlight an expression in the current step on which the 
student should focus next. 

  "Suggest an action here" lets the companion recommend an action to perform on the current step. 

  "Perform an elementary step here" lets the companion perform the recommended action on the current 
step. 

  "Perform a step here" lets the companion perform a calculation on the current step; this generally 
involves several elementary calculations. 

  

Important note: the companion always bases his/her advice on the current step (i.e. the step containing the 
cursor or the selection and which is outlined in green).  When the student's working out is going in the 
wrong direction, the companion will not suggest going back to an earlier step (this is planned in a later 
version of Aplusix).  As a result, the companion's advice may not be very helpful and it may be best to start 
again from the initial step. 

  

It is not possible to edit steps performed by a companion but it is possible to delete them. 

  

Below is a description of the skills of each of the three companions as implemented in the November 2010 
version. 

  

Chloé 

Chloé is    years old.  She can perform calculations with integers, decimals and fractions, but not with 
surds.  She can expand and simplify expressions, and perform simple factorisations.  She does not know 
quadratic or cubic identities.  She can solve some linear equations.  She does not know how to solve 
inequalities or simultaneous equations.  She cannot deal with algebraic fractions with a non constant 
denominator. 

  

Julien 

Julien is    years old.  He can perform calculations with integers, decimals and fractions, as well as surds, 
but he doesn't know about conjugate expressions.  He can expand, simplify and factorise expressions, but 
he is unable to use the discriminant.  He can use quadratic identities but he doesn't know cubic 
identities.  He can solve linear and quadratic equations (except when it is necessary to use the 
discriminant), and linear inequalities.  He is unable to solve simultaneous equations (for the time 
being).  He cannot deal with algebraic fractions with a non constant denominator. 

  

Olivia 

Olivia is    years old.  She can perform calculations with integers, decimals and fractions, as well as surds, 
and knows about conjugate expressions.  She can expand, simplify and factorise expressions, including 
when it is necessary to use the discriminant.  She can use quadratic and cubic identities.  She can solve 
linear and quadratic equations (using the discriminant or not), and linear inequalities.  She is unable to 
solve simultaneous equations (for the time being).  She cannot deal with algebraic fractions with a non 
constant denominator (for the time being). 
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Note: a companion's age should not be taken as a strong indication of their level (as the knowledge 
acquired at a given age varies between countries).  It is merely used to select a companion.  If the 
companion performs calculations which are too complex, the student should select a younger 
companion.  If the companion is unable to solve a question or perform calculation steps which are too 
basic, the student should select an older companion. 
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7.4.   Scores 

  

Scores are calculated by considering the progress made with correct calculations. When nearly in solved 
form, with correct calculations, the score is close to the maximum. When a solved form has been given but 
“Solved” has not been indicated, the score will not be maximal. 

  

If there are incorrect calculations, Aplusix considers the situation before the first incorrect calculation. If the 
score is not high, Aplusix looks at the calculations after the incorrect one and may increase the score. 

  

There is no score for problems. 
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8.  Teacher tools 
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8.1. Statistics 

  

The “Past activities” menu has a “Statistics” facility that opens a window for selecting a “population” (set of 
past activities of students) that can be analysed statistically. The start date and end date for the activities 
must be specified. An activity and a family or exercise files can be selected. 

  

In addition, teachers have the option to select specific classes and students within these classes. If no 
student is selected, all students in the selected classes are included in the analysis. 

  

The Statistics window displays a table and a graph (histogram or time curve). It is possible to change the 
population and the information displayed. 

  

Information that can be displayed includes: 

-   Attempted questions (total, average, standard deviation by exercise). 

-   Correctly solved questions (total, average, standard deviation by exercise). 

-   Calculation errors (total, average, standard deviation by exercise). 

-   Scores (total, average, standard deviation by exercise - for tests only). 

-   Time (total, average, standard deviation by exercises – time units must be edited). 

  

The entities to be displayed are students or classes. 

  

The table can be sorted by clicking on the heading of the column to be sorted. This action propagates 
automatically to the histogram. 

  

The table and the histogram can be printed. 
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When the selected start and end dates are the current date, the window is updated each    seconds so 
that teachers can view their students' progress in real time. It is possible to change the time interval 
between updates (refresh delay) via the "Automatic refresh" menu. 
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8.2. Settings 

  

There are a number of settings that allows Aplusix to be customised for each class. Each class is assigned its 
own settings. Teachers can modify the settings for a particular class by logging in in the context of this class 
and using the “All settings” item from the “Settings” menu. Below is the list of settings. 

  

Equivalence 

-  Equivalence checks can be set to “Permanent” or “On request” by the student, possibly limited   or   
checks or “Student choice”. 

-  Scope allows “On request” equivalence checks to be performed for all transitions or just the current one. 

-  Correct reasoning is available when equivalent checks are permanent. If this setting is enabled, the 
student can create a new step or duplicate a step only if the current step is equivalent to the previous one. 

  

Solved 

-  Disallow ill-formed : when the box is checked, if there are ill-formed expressions Aplusix asks students to 
delete them before considering whether this question is solved. 

-  Disallow incorrect : When the box is checked, if there are calculation errors on one branch, Aplusix asks 
students to correct them before considering whether the question is solved. 

  

Calculations 

- Theses settings are described in the “Calculation commands” section. 

  

Exercises 

-  Questions in an exercise file may appear in a Random order, or not. 

-  The student can be strongly invited to comment his/her calculation steps, or not. 

-  The student may have access to the solution, or not. 

-  In “Test” mode, the student may backtrack to an already completed question to edit the solution. 

-  Test duration specifies the duration of tests in the Map in minutes. 

  

Companions 

- The presence or not of companions, 

- The possibility of using or not each of the functions of the companion. 

  

Editing 

-  The small arrow and the “return” key provide a new empty step or a duplicate of the current step. This 
may be set by the teacher or left to the student’s choice. 

-  All steps can be edited (when the box is checked) or only the last one. 

-  When the Selection box is not checked, the student can neither select an expression nor cut, copy, paste 
or drag&drop. 

-  Inserting a left bracket “(” with the keyboard may (or may not) produce the matching bracket “)” at the 
same time. 

-  Inserting a “/” on the keyboard may produce an empty fraction or its numerator may be the expression to 
the left of the cursor. 

  

Miscellaneous 
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-  When the student creation box is checked, the “New student” button on the start window of Aplusix 
allows a student to create an account in this class. Otherwise, student accounts for this class must be 
created using administration application. 

-  Highest score indicates the highest score a student can achieve when solving a question. 
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9.  Domains 

  

Aplusix 3 comprises two domains: one for equivalence checks (it is the set of expressions for which Aplusix 
is able to perform these checks), another one for checking solutions and awarding scores. 

  

Question type: Calculate 

Checks: The calculated form of the expression must be a real number. 

Solution: As above. 

  

Question type: Write in fractional form 

Checks : The calculated form of the expression must be a rational number. 

Solution: As above. 

  

Question type: Write in decimal form 

Checks : The calculated form of the expression must be a decimal number. 

Solution: As above. 

  

Question type: Expand and simplify 

Checks : Polynomial expressions in one or several variables. 

Solution: As above. 

  

Type of exercise: Simplify 

Checks : Rational expressions of one variable. The maximum degree of numerators is 4.The maximum 
degree of denominators is 2. 

Solution: As above. 

  

Question type: Factorise 

Checks : Polynomial expressions in one variable and degree no higher than 4, or in two variables and 
degree at most 2. 

Solution: Polynomial expressions in   or   variables and degree at most 2. 

  

Question type: Solving equations 

Checks : Polynomial equations in one unknown and degree no higher than   and rational equations yielding 
such polynomial equations. 

Solution: Polynomial equations in one unknown of degree at most 2. 

  

Question type: Solving inequalities 

Checks : Polynomial inequalities in one unknown and degree no higher than   and rational inequalities 
yielding such polynomial inequalities. 

Solution: Linear inequalities in one unknown 

  

Question type: Solving combinations of relations of one variable 

Checks : Combination with “and”, “or”, “not” of equations or inequalities of the above form. 

Solution: As above. 
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Question type: Solving simultaneous equations 

Checks : 1-10 equations and 2-10 unknowns. 

Solution: 1-2 equations and   unknowns. 

  

Numbers within expressions may be written as integers, decimals, fractions and square roots. Exponents 
must be integers (positive, negative or zero). 

  

Integers must be between      and     . Decimals must have no more than   significant figures. When 
these constraints are not satisfied, the numbers are said to be “out of domain” and are displayed in blue. 
Similarly, expressions whose value is out of domain are also out of domain. This is the case of, for example, 
        +          . 

  

Refer to the “Solution and checking student's work” section to view the expected forms of solutions for 
correctly solved questions. 
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10. Print, make a PDF file 
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10.1. Print 

  

To print the contents of the Aplusix window, choose "File | Print",  select the printer in the printing 
window, make the adjustments and to ask for the printing. 

The adjustments are accessible by the toolbar. It is possible 

- To indicate one's name and to supply a title with the "Title" button, 

- To set a portrait or landscape orientation, 

- To increase or to decrease the size of the characters, 

- To increase or to decrease the left margin, 

- To increase or to decrease the top and bottom margins. 
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10.2.  Make a PDF file 

  

To make a file PDF with the contents of the Aplusix window,  it is necessary to have a "PDF printer" on the 
computer. If it is not the case, it is possible to have one by installing PDFCreator which is free and can be 
downloaded by typing "PDFCreator" in a search engine. 

  

To make a file PDF with the contents of the Aplusix window, choose "File | Print", select the PDF printer in 
the printing window, make the adjustments for printing and ask for printing. 
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11.  Miscellaneous 
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11.1.  Modifications of the size and the font 

  

Aplusix uses 3 fonts: 

- A font for the math with a big size for the steps and with a normal size for the math of the messages of 
type "text  and math", 

- A font for the text of the messages of type "text  and math", 

- A font for buttons, simple messages, etc. 

  

The menu "Settings | Font" allows to modify fonts and their sizes. 

  

The menu "zoom" of the virtual keyboard allows to increase and to decrease the size of the characters of 
the virtual keyboard. 

  

Aplusix allows to modify neither the size of the characters of the banner of the window nor then size of the 
characters of the menus. 

This type of modification can be made under Windows, in the part "Display of the configuration panel. 
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11.2. Deleting data 

  

Work undertaken in Aplusix by students and teachers is recorded so that it can be reviewed at a later 
date.  On a server installation, this data can be partly or totally deleted using the AplusixAdmin 
application.  Please refer to the AplusixAdmin manual for instructions. 

  

On a standalone computer, it is not necessary to delete data unless the application has been used very 
intensively.  On Windows, this can be done by navigating to the "Classes" folder and the "Home" folder 
within it.  This folder contains a folder for each user.  All folders within user folders named "D-xxx" (where 
"xxx" represents a date) can safely be deleted: they contain all work undertaken on that particular date. 

  

 


